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2 Introduction

The scope of SAFE WT 4.1 "Meta-model implementation" is the implementation of the SAFE
meta-model in WT 3.5. The requirements for SAFE WT 4.1 "Meta-model implementation" are
described in [1]. The traceability between these requirements and the higher-level SAFE
requirements is captured in the respective requirements traceability document.

This report summarizes the contributions to the deliverable D4.1.d and gives a manual for the
usage of SAFE Tool Platform. The goal of the deliverable is to create an initial version of an Ecore
for system, hardware and software in Eclipse.

It consists of two independent parts.

o A set of Eclipse based plug-ins created by itemis France. This set is an implementation of
SAFE target tool platform.

¢ A Meta-Model Gen tool (MMGen) developed by itemis France. This includes the generation
of Ecore metamodel, EMF code implementation and XSD schema.

©2014 The SAFE Consortium 4 (18)
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3 SAFE Tool Platform

This chapter describes the contribution from itemis France to WT4.1.

3.1 License

The code of the platform from itemis France is made available under the terms of the ITEA2 SAFE
project consortium agreement.

3.2 Installation guide

3.2.1  Prerequisites

Windows Vista, 7
Eclipse Kepler SR2

. If you expect to install SAFE Tool Platform by checking out source code or by update site,
you should also install Sphinx, EATOP (EAST-ADL Tool Platform) and ARTOP (AUTOSAR
Tool Platform).

You can:

- either simply apply the SAFE target definition, which you can find in:
https://safe.offis.de/svn/svndav/34 WP4 Technology Platform/10 WT4 1 Meta mod
el _implementation/30 Development artifacts/SAFE Tool Platform/org.safe.targetdefs/
kepler/kepler.target

- Or use update site for installing each of the following:

e Nebula : http://download.eclipse.org/technology/nebula/snapshot

e Sphinx: http://download.eclipse.org/sphinx/updates/interim

e ARTOP: https://www.artop.org/containers/artop-sdk-update-site-4.2/

e EATOP: http://download.eclipse.org/eatop/updates/interim

3.2.2 Installation

You can install SAFE Tool Platform with one of the following solutions. Please make sure that
you have Nebula, Sphinx, ARTOP and EATOP installed in your Eclipse, if you choose solution
1 or solution 2.

1. Source code

If you have already an Eclipse Kepler installed, you could check out the source and import all
the org.safe.* plug-ins under SAFE_Tool Patform directory into your workspace. The URL of
source repository for SAFE is:

https://safe.offis.de/svn/svndav/34 WP4 Technology Platform/10 WT4 1 Meta model impl
ementation/30 Development artifacts/SAFE Tool Platform

2. SAFE Tool Platform update site

http://safe.offis.de/updates/safe/platform/updates/interim/

3. SAFE Technology Demonstrator Download

©2014 The SAFE Consortium 5 (18)
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The SAFE Technology Demonstrator is a collection of examples that demonstrate the features
and capabilities of the underlying platform. It is a standalone application that can be used to
conveniently explore SAFE. It does not require an existing Eclipse installation.

http://safe.offis.de/updates/safe/demonstrator/downloads/

3.3 Main features

1. SAFE project/file creation support
It provides services for creating SAFE project and file in the workspace.

2. SAFE perspective

The SAFE perspective contains a SAFE explorer view and a SAFE form editor. They are
created operating on shared model instances in Sphinx-based modeling tool applications.

3. SAFE reference mechanism

This feature allows SAFE models could make reference to AUTOSAR and EAST-ADL
items.

3.4 User Guide

For more details guide tour, you could reference to the SAFE cheat sheet, “Help -> Cheat sheets... ->
SAFE Tool Development -> Guided Tour of the SAFE Technology Demonstrator”.

3.4.1 Open SAFE perspective

In the main menu, select “Window > Open Perspective > Other”, and then select “SAFE”.

3.4.2 Create a SAFE project

1. Inthe main menu select “File > New > SAFE Project”.

2. A dialog box invites you to name the project. You can set the SAFE release used
for the project by selecting “Alternate Release” and by choosing a release in the list
or decide to use the “Workspace default release”. Click “Next”.

& New SAFE Project Ey X

A

SAFE Project

Create new SAFE project.

Project name: safelO|
¥| Use default location
C\Work\Workspace\runtime-New_configuration\safe10 Browse

SAFE release options

Workspace default release (SAFE 1.0} Configure Workspace Settings...
@) Alternate release SAFE 1.0 (http://safe-project.eu/1.0.1) hd
@ Back Next > ‘ l Finish ] ‘ Cancel
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3. A second page is opened to select the “AUTOSAR Nature”. You can set the
AUTOSAR release by selecting “Alternate Release” and by choosing a release in the
list or decide to use the “Workspace default release”. Click “Next”.

£ New SAFE Project (] e S
P
AUTOSAR Nature
Create new AUTOSAR Nature
AUTOSAR release options
() Workspace default release (AUTOSAR 4.1.1) Configure Workspace Settings...
(@) Alternate release AUTOSAR 4.1.1 (http://autosar.org/schema/r4.0) hd
@ l < Back H Next > ] I Finish I I Cancel l

4. A third page is opened to select the “EAST-ADL Nature”. Set the EAST-ADL release

by selecting “Alternate Release” and by choosing a release in the list or decide to use
the “Workspace default release’.

5. Now you have set projects properties, and you can click on the “Finish” button to
perform creation.

343 Create a SAFE file

1. Right click on a created SAFE project, select “New >SAFE file”.

©2014 The SAFE Consortium 7 (18)
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B SATE- Eclipse SDK ;s ~ R+ W i = |

File Edit Navigate Search Project Validate EATOP Example Plug-in Run Window Help

rq - H v DT vigvigivil vy v Ow v o

=@\ SAFE Explorer | [ Project Explorer =% =D
- €2 ARTOP411
- 2 AUTOSAR403
% EASTADL21
& HUMMINGBIRD10
& HUMMINGBIRD20

&1 Pjtl
&1 pjt2
- 5 SAFE
sy
" Bz New *| 9 Project..
Go e @ AUTOSAR File
= Copy Ctrl+C | /A EAST-ADL File
Paste Ctrl+V | I File
® Delete Delete | & Folder
Move... & Hummingbird10 Model
Rename... F2 | @ InstanceModel20 Model
e Import... =3 SAFF File
I Export... w8\ SAFE Project
£ Refresh F5 | @ TypeModel20 Model
Close Project I Example...
Validate C% Other... Ctrl+N
Run As 4
Debug As 4
Profile As 4
Team °
Compare With 4
Restore from Local History...
Configure 4
Source o
Properties Alt+Enter
Resource Configurations L4

2. A wizard is opened. You can name the file or choose to keep the default name
"default.safe". A “SAFEPackage” root can be automatically added into the file by
selecting “With a SAFEpackage” in the “SAFEPpackage Creation” section.

£ New SAFE File E™

—

New SAFE File

Create a new SAFE file

Enter or select the parent folder:
safel0
B e
22 ARTOP411
#2 AUTOSAR403
- ¥ EASTADL21
2 HUMMINGBIRD10
- 8B SAFE
£ safel0

File name: default.safe

SAFEPackage creation
With a SAFEPackage
SAFERootPackage

@ [ Finish J I Cancel

3. Then click on the “Finish” button to perform creation.
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3.4.4 Create a SAFE object

1. Open the “SAFE explorer view”. Expand project composition and elements below
SAFE file. Double click on SAFE element below SAFE file. The project editor view
IS now opened.

= SAFE - SAFELO/default.safe - Eclipse = | [E |-
File Edit Navigate Search Project Model Form Editor Validate Run Window Help
CivHE -0~ Qi@ F il v G o] Quick Access | 5| & Java [ma SAFE]™ Artop 5 Resource
|| w4\ SAFE Explorer 52 = O | *defaultsafe & =g
BE ¥

SAFE Contents Tree

aBarm
» [ defaultanml
> B defaultLanxml
- 82 AUTOSAR40 This section enables the contents of this element to be edited.

default.safe Contents Show Types

> % EASTADL21 4 4 SAFE
L
© SAFEL0 + SAFERootPacl—
- &) defaultsafe New Child » Element » | %2 Autosar Hardware Safety Extension
- & test-arsafe @ Undo Remove CtrleZ Sub Package | % Autosar System Safety Extension
- o test-ea.safe Redo CuilsY | “¥  Autosar Vfb Safety Extension
“¢ Chromosome Application Safety Extension
¢ Cut Ctrl+X +£ Chromosome System Safety Extension
= Copy Ctrl+C “¢ Design Level Safety Extension
Paste Curl+v “¢ Functional Safety Extension
® Delete Delete “¢ Hardware Safety Extension
R “¢ Hazardand Risk Safety Extension
DebigRs +¢ Implementation Safety Extension
R8s * #¢ Multi Level Safety Extension
Team 4 % Restrictable
Compare With © #§  Software Safety Extension
Replace With » Variant
= Properties 2 " <
Show Properties View
+ SAFERootPackage
Remove from Context Ctrl+Alt+ Shift+Down
Advanced  Property VaIuE
Category =
Short Name = SAFERootPackage
Uuid =

<4 SAFERootPackage

2. Expand elements, right click on an element, e.g., SAFEPackage, a menu appears,
select “New Child > Element > Functional Safety Extension” and left click on it. You
should now see a new Functional Safety Extension element below the selected
package.

3.45 Explorer SAFE project

1. To open the editor in the main view, you have to select the SAFE element below the
SAFE file in the “SAFE explorer view” and double click on it.

6 SAFE - safel0/default.safe - Eclipse SDK a
File Edit Navigate Search Project Model Form Editor Validate EATOP Example Plug-in Run Window Help

ri v HrOvQAvigwigviir v Ow o v
w8 SAFE Explorer # [ Project Explor.. 7 i default.safe &

S SAFE Contents Tree
-2 ARTOP411

- # AUTOSAR403
- ¥ EASTADL21

- 1% HUMMINGBIRD10 This section enables the contents of this element to be edited.
1 HUMMINGBIRD20 4 4 SAFE

1 Pjtl + SAFERootPackage

o pjt2
U5 SAFE
¥ safel0

= .settings

SAFE Contents

"

¥ .project
< 4 defaultsafe
4 4 SAFE [SAFE]
+ SAFERootPackage [SAFEPackage] = & Properties 5

+ SAFE [SAFE]

Advanced Property Value
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2. The editor is opened and you can see a tree representation of the elements it
contains. You can explore project composition by expanding elements below the
root object.

3.4.6  Edit SAFE object properties

1. You can modify any of the project elements by using the editor and the properties
tab displayed below the view. Open the editor.

2. Expand project elements and select one element. You can see the properties of the
element in a tab below the editor view.

3. Change the value of the field “Short name” in its properties. Once your modification
is made you can observe that the name of the SAFE object changed in the editor
view.

& SAFE - safe10/default.safe - Eclipse SDKmli - -_-—

File Edit Navigate Search Project Model Form Editor Validate EATOP Example Plug-in Run Window Help

Ml sy Oy v v glw - - 5w > | =

« *SAFE Explor... # B & *default.safe 5

SAFE Contents Tree

I
&

£ ARTOP411

. :E:PAUTOSAMOB SAFE Contents
- #& EASTADL21
. 1% HUMMINGBIRD10 This section enables the contents of this element to be edited.
1 HUMMINGBIRD20 «+ 4 SAFE
@1 Pjtl < rootPackage
o1 pjt2
£ SAFE
4 £5 safel0
= settings _
% project = Properties ¥ | €] Error Log # Plug-in Registry
« # default.safe + rootPackage [SAFEPackage]
4 4 SAFE [SAFE
+ rDDE[Packlge [SAFEPackage] Advanced Froperty Zalue
Category

Short Name = rootPackage
Uuid =

4. Each time you modify or add elements in the project a star appears in the top label
of the editor view, which means that modification has been made but not saved. To
save modifications simply click on the disk item in the top menu toolbar or use
“ctrl+s” shortcut.

3.4.7 Reference to AUTOSAR and EAST-ADL

With ARTOP and EATOP installed along SAFE platform, you can use reference
mechanism making references to EAST-ADL and AUTOSAR elements. Once serialized,
SAFE file only contain a reference to AUTOSAR/EAST-ADL elements, and
AUTOSAR/EAST-ADL data are located in standard AUTOSAR/EAST-ADL files.

1. Create a SAFE file.

2. Add AUTOSAR and EAST-ADL referable elements exactly the same way that you
would do for other SAFE elements. Click on the attribute filed to get the available
referenced models:

1) If the available referenced models are already loaded, then you can directly
choose the model that you would like to reference.

©2014 The SAFE Consortium 10 (18)
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@ test-ea.safe B test-arsafe &2

SAFE Contents Tree

test-ar.safe Contents

This section enables the contents of this element to be edited.
4 4 SAFE
4 4 SAFERootPackage
+ arHwSafetyExl

= Properties & | @] Error Log

+ arHwSafetyEx1 [AutosarHardwareSafetyExtension]

Advanced Froperty Value
Category =
Hardware Part Safety Analysis
Name "= arHwSafetyExName
Ramdom Hardware Part Failure
Scope # hwElement-40
Short Name b
Uuid [E hwElement-40

hwElement-41

< | I

2) If the available referenced models are not yet loaded, then a message
object is shown in the list: “Waiting for models being loaded...” The models are
loaded asynchronously in background. It may take several minutes if the
loaded models are huge. You can continue with other stuffs, and come back
to refresh and get the reachable models some time later.

3 Sphinx - asafelﬂ,flest-eastadlsafe'- Eclipse SDK
Gle Edit Navigate Search Project EATOP Example Plug-in Run Window Help

i FBYOTAviYvigyi v > > x| Quick Access 2| &' Java ™ Artop ::Res
@ Model Explorer & = Project Bxplo.. & test-autosarsafe  ¥htest-eastadl.safe & - =
+ 15 asafel0 - SAFE Contents Tree
& .settings
2 .projeft SAFE Contents Show Types
£ autosard1Lanml This section enables the contents of this element to be edited.
= EAST-ADLeaxml 4 ¢ SAFE
A test1.safe 4 + SAFERootPackage
4 test-autosar.safe 4 4 hwcomponentl
< & test-eastad|.safe 4 + hwcomponenttypel
4 4+ SAFE [SAFE] 4 4+ hweonnectorl
+ + SAFERootPackage [SAFEPackage] + Hardware Connector port
4 4 hwecomponentl [EMTypeHwCo + iohardwaredpinl
4 %+ hwcomponenttypel [Hardw:
4 ¢ hwconnectorl [HardwareC
4 Hardware Connector pc
+ iohardwaredpin1 [IOHard\
¥ autosar411
? EAST"ADPM_ o B Properties & = ati E L P e s e #v=a
@ External Plug-in Libraries
& HUMMINGRIRD20 + Hardware Connector port [HardwareConnector_port]
@ org.edipse.sphinx.examples.hummingbir Advanced Property Value
@ org.edlipse.sphinx.examples.hummingbir Hardware Component Prototype
1 SAFE Hardware Pin *+ iohardwaredpin1 [hwcomponenttype fiohardwaredpin1] <

Waiting for models being loaded...

3. When opening a SAFE file that references to EAST-ADL or AUTOSAR elements,
the reference proxy is resolved. The referenced EAST-ADL/AUTOSAR elements
are located in a separated EAST-ADL or AUTOSAR file.

If the associated referenced file has already been loaded, the reference proxy will
be resolved immediately.

©2014 The SAFE Consortium 11 (18)
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Otherwise, the file will be loaded asynchronously. For example, the EAST-ADL
element “ijohwPin1” is declared in an EAST-ADL file other than the current SAFE file,
the reference proxy is not resolved immediately.

o test-easafe 2 | o test-arsafe

SAFE Contents Tree

test-ea.safe Contents Show Types

This section enables the contents of this element to be edited.

4 4 SAFE
4 <4 SAFERootPackage
4 4 hwSafetyExtension
4 4 Hardware Software Interface Specification
4 Hardware Software Interface Element

El Properties 2 = (&% T =

4+ Hardware Software Interface Element [HardwareSoftwarelnterfaceElement]

Advanced Property Value
Basic Software Function Port & eay/#/EARoot/hwFunctionTypel/functionFlowPort17type=FunctionFlowPort
Category =
Connector
Hardware Pin L] eay/#/EARoot/hwComponentTypel/ichwPinl?type=I0HardwarePin
Rationale t=
Short Name =
Type "= VOLATILE_MEMORY

Uuid

You have to refresh and get the reference resolved. For example, you can click on
“Hardware Software Interface Specification”, re-click on “Hardware Software Interface
Element”, then you will find that the “iohwPin1” is resolved.

o test-easafe 52 | o test-arsafe

SAFE Contents Tree

test-ea.safe Contents

This section enables the contents of this element to be edited.

4 <4 SAFE
4 < SAFERootPackage
4 <4 hwSafetyExtension
4 4 Hardware Software Interface Specification
+ Hardware Software Interface Element

E Properties 2

+ Hardware Software Interface Element [HardwareSoftwarelnterfaceElement]

Advanced Property Value
Basic Software Function Part = functionFlowPortl
Category t=
Connector
Hardware Pin = johwPinl
Rationale =
Short Name t=
Type = VOLATILE_MEMCRY

Uuid
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4 SAFE MM Generator Tool

This SAFE MMGen tool is contributed by itemis France. It is refactored and enhanced to be
adapted for the SAFE meta-model by itemis France. With the adaptations done in the WT3.5
meta-model, the tool generates an Ecore for the SAFE meta-model, as well as an XSD schema.

41 License

The code provided by itemis France is made available under the Eclipse public license EPL. The
code provided by Continental Automotive which is part of this deliverable is made available under
the terms of the Eclipse public license EPL.

4.2 Abbreviations

o Artop See AUTOSAR Tool Platform Website www.artop.org
o EA Enterprise Architect

e EAST-ADL See EAST-ADL association at www.east-adl.info

o SAFE See SAFE project Website www.safe-project.eu

4.3 Installation guide

4.3.1 Prerequisites

1. Windows XP, Vista, 7 (Linux or Mac is not supported)
2. Enterprise Architect 9.1 or greater
3. Eclipse 32Bit

4. Install the following software in your Eclipse:
Nebula: http://download.eclipse.org/technology/nebula/snapshot

Sphinx: http://download.eclipse.org/sphinx/updates/interim

Xtext and Xtend 2.5.3:
http://download.eclipse.org/modeling/tmf/xtext/updates/composite/releases

432 Source checkout

1. Clone the git://git.eclipse.org/qgitroot/eatop/org.eclipse.eatop.qgit/metamodelgen EATOP
MMGen Tool repository to your computer.

2. Add Enterprise Architect APl in EATOP MMGen Tool:

Copy eaapi.jar from your installation, e.qg., C:\Program Files (x86)\Sparx Systems\EA\Java API,
to:

org.eclipse.eatop.eaadapter/lib

org.eclipse.eatop.metamodelgen/lib

©2014 The SAFE Consortium 13 (18)
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Copy SSJavaCcoM.dll to:
org.eclipse.eatop.eaadapter
org.eclipse.eatop.eaadapter/lib
org.eclipse.eatop.metamodelgen

org.eclipse.eatop.metamodelgen/lib

3. Check out the plugins org.safe.* from the SAFE MMGen tools repository into your
workspace. The URL of source repository for SAFE MMGen tool is:
https://safe.offis.de/svn/svndav/34 WP4 Technology Platform/10 WT4 1 Meta model i
mplementation/30 _Development artifacts/tools

4. Apply the target definition 4.3.target in org.safe.metamodelgen.tool.targetdefs.

4.4 User guide

441  Step 1: Start MMGen

Execute “Run Eclipse Application”. This operation opens a new Eclipse instance, including the
MMGen tool plug-ins from your workspace. The further work is now done in the second Eclipse
instance.

4.4.2 Step 2: Create a project for SAFE metamodel

In the second Eclipse instance:

1. Create a new Project, “File->New->Other->Java Project’”. Choose a name, e.g.,
“org.safe.metamodel10”, and press “finish”

2. Create a new folder “model” within this project. Copy the SAFE metamodel Enterprise
Architect EAP file into the “model” file. Rename the file to be “safe10.eap”.

443  Step 3: Create SAFE Ecore model

1. Import the following projects from the SAFE MMGen tools repository or MMGen.zip into
the MMGen’s runtime workspace:

org.eatop.stub
org.artop.stub

2. Right click on the “safe.eap” file, select “SAFE — Generate SAFE Ecore MM”, then select one
of the following:

- “Generate (persistence mapping only) Ecore only”: to generate persistence mapping Ecore
only

- “Generate Ecore + MM EMF Code”. to generate persistence mapping Ecore and the
metamodel code implementation

- “Generate Ecore + XSD Schema”: to generate persistence mapping Ecore and the XSD
shcema

©2014 The SAFE Consortium 14 (18)
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- “Generate All (Ecore + MM EMF Code + XSD Schema)”: to generate persistence mapping
Ecore, metamodel code implementation and the XSD schema.

Note: Please make sure that the following resources should be removed before you
start to generate the metamodel:

- org.safe.metamodel10: /src-gen, IMETA-INF, /model/safe.ecore,
/model/safe10.genmodel, /model/safel0.xsd, /model/autosarStub.ecore,
/model/autosarStub.genmodel, /model/eastadIStub.ecore, ,

/model/eastadIStub.genmodel, build.properties, plugin.properties, plugin.xmil

- org.safe.metamodel10.edit plugin

% Resource - Eclipse Platform

File Edit Source Refactor Navigate Search Project Validate Run Window Help

Tain R R R AR - Quick.
[2 Project Explorer | [ Package Explorer 22~ = O
Bg v
> B4 Plug-in Dependencies &
» 2 src
: = META-INF
4 = model
=[]
#] autosarSt New »
& autosarSt
#) eastad|St| Open F3
@ castadisyy  OPen With '
2 SAFE_WT] Show In Alt+Shift+W »
=/ SAFE WT] [ Copy Ctrl+C
|5l SAFE_WT| B2 Copy Qualified Name
|2 safe10_20 [5 Paste Ctrl+V
|5 safel0_20 ¥ Delete Delete
8 s5afel0-20 g path ,
5 safel0-20 gefacor Alt+Shift+T »
= safelQ.ea
#) safel0.eq| s Import..
& safel0.ge i Export..
[§ safelOxs{ < Refresh F5
b build.proper Assign Working Sets...
pluGINProRs  yjjigate Value
S | oy »
x= org:safe:test Run As ' false
B Team 4 true
: = sky.test )
+ 12 xsd.generator.t Compare wlth ’ March 18, 2014 a
Replace With 4 false
% Outline 2 Sphinx - Generate XSD Schema CA\Work\Workspz
o . Create HTML safelO.eap
An outline is notavaill  £xpop - Generate EATOP Ecore MM » :

Sphinx - Generate XML Persistence Mapping
Sphinx - Generate XSD2Schema (Complete)
SAFE - Generate SAFE Ecore MM 4 Generate (persistence mapping) Ecore only
Generate Ecore + MM EMF Code

Generate Ecore + XSD Schema

Generate All (Ecore + MM EMF Code + XSD Schema)

safel0.eap - org.safe.m

R Properties Alt+Enter
Wesn=ls

Wait until the Ecore metamodel generation has been finished.

Note: at the end of the generation, a validation of the Ecore is performed. Some
validation failure error is pumped up. It does not affect the generated metamodel, the
reason is caused by some default values not setting. Just click “OK”.
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@ Error

.
-

(

Dl

) Generated the Ecore.
Attention, the generated Ecore contains errors, please validate it to see the errors

N

5 S |

r

The generated SAFE Ecore:

#] safel0.ecore i

‘|E|

platform;/resource/org.safe.metamodel10/model/safel0.ecore|

4 & safeld

¥ Tasks B Properties 22 @] Error Log

The g

I f= MetaData

#= ExtendedMetaData
b 8= XMLPersistenceMappingExtendedMetaData
2 ASILDecomposedEnum
ASILEnum
DevelopmentCategory
FunctionBehaviorKind

SafeElementType

g mg

[

g

I

g

I

g

Boolean [java.lang.Boolean]

Date [javaxxml.datatype XMLGregorianCalendar]
Float [java.lang.Double]

Identifier [java.lang.String]

Integer [java.lang.Integer]

Mumerical [java.lang.String]

String [java.lang.String]

UriString [java.netUR]]

UrlString [java.net.URL]

FilterExpression -= FormulaExpression

8= MetaData

I f= GenModel

- #= ExtendedMetaData

& f= XMLPersistenceMappingExtendedMetaData
& FormulaExpression

- [0 Of 0% Of Of Of O8 O% O%8 O

H FormulaExpression - > Identifiable

H AbstractReference

v H AutosarReference -» AbstractReference
H CHROMOSOMEReference -= AbstractReference
H EastAdIReference -» AbstractReference
H Annlicatinn - CHROMOSOMFEReference

roplems

enerated SAFE XSD schema:
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[51 safelOxsd & =g
2= <xsd:schema xmlns:Q1l="http://east-adl.info/2.1.12" xmlns:Q2="http://autosar.org/schema/r4.8" xmlns:SAFE="http://safe-prc »

3 <xsd:import namespace="http://autosar.org/schema/r4.8" schemalocation="platform:/plugin/org.artop.aal.autosar4ll/model=|
4 <xsd:import namespace="http://east-adl.info/2.1.12" schemalocation="platform:/plugin/org.eatop.eel.eastadl2112/model /e
5 <xsd:element name="SAFE" type="SAFF:SAFE"/>

6% «<xsd:complexType name="FILTER-EXPRESSION">

7e <xsd:sequence>
8
9

<xsd:element maxOccurs="1" minOccurs="1" name="SHORT-NAME" type="SAFE:IDENTIFIER"/>
<xsd:element maxOccurs="1" minOccurs="1" name="FORMULA" type="xsd:string”/>

10 </xsd:sequence>
11 <xsd:attribute name="CATEGORY" type="SAFE:IDENTIFIER" use="optional"/>
12 <xsd:attribute name="UUID" type="xsd:string" use="optional"/>

13 </xsd:complexType>
14=  <xsd:complexType name="FORMULA-EXPRESSION™>

15 <xsd:sequence>

16 <xsd:element maxOccurs="1" minOccurs="1" name="SHORT-NAME" type="SAFE:IDENTIFIER"/>

17 <xsd:element maxOccurs="1" minOccurs="1" name="FORMULA" type="xsd:string”/>

18 </xsd:sequence>

19 <xsd:attribute name="CATEGORY" type="SAFE:IDENTIFIER" use="optional"”/>

20 <xsd:attribute name="UWID" type="xsd:string" use="optional"/>

21 </xsd:complexType>

225 <xsd:complexType name="ABSTRACT-REFERENCE"> -
< | I | 3

Design |Source

+ITasks B Properties & © T =8

r Loa Problems
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